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Abstract 
 
 
The JRC TREES-3 project aims at estimating forest cover changes at continental and regional levels 
for the tropical belt for the periods 1990-2000 and 2000-(2005)-2010 based on a systematic sample 
of forest cover change maps. An operational system has been developed for the processing and 
change assessment of a large data set of multi-temporal medium resolution imagery (sample units of 
20 km x 20 km size analysed from with Landsat imagery).  The main task is to assess as accurately 
as possible for each sample unit the forest cover and forest cover change between two dates. 
 
The analysis includes a crucial final step of visual verification and final assignment of land cover 
labels which is carried out by forestry national officers or remote sensing experts from tropical 
countries. The visual interpretation is conducted interdependently on two-date imagery to verify and 
to adjust the labels pre-assigned to each segment for the different dates. A dedicated stand-alone 
application has been developed for this purpose. The application is a graphical user interface, called 
the JRC Land Cover Change Validation Tool. The aim of this tool is to provide a user-friendly 
interface, with an optimised set of commands to navigate through and assess a given dataset of 
satellite imagery and land cover maps, and to correct easily the land-cover labels as appropriate. 
FAO is collaborating with JRC in this work under the Global Forest Resource Assessment (FRA) 
Remote Sensing Survey. JRC has added functionality to the tool to enable labelling of land-use 
classes that are part of the FRA classification. 
 
The present technical document, entitled “User Manual for the JRC Land Cover/Use Change 
Validation Tool” describes the steps for the installation of the tool on a personal computer, as well as 
the detailed features of this dedicated graphical user interface. The authors welcome feedback from 
potential users of the tool, in particular reporting of any potential software issue or providing 
suggestions for improvements of future versions of the tool. 
 
 
 
 

 
1 D. Simonetti worked at JRC under the "Specific Contract No 371 implementing Framework Contract No 
DI/05712", contract signed between the European Commission and the ONE4EU Consortium which includes 
REGGIANI Spa as contractor. 
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1. Background on the JRC TREES-3 project 
 
Research groups at the Joint Research Centre (JRC) are developing methods for monitoring forest cover 
resources in a global perspective. In particular the JRC TREES-3 project2 aims at estimating forest cover 
changes at continental and regional levels for the Tropical belt for the periods 1990-2000 and 2000-
(2005)-2010 based on a systematic sample of forest cover change maps. The project is carried out in a 
collaborative partnership with the Remote Sensing Survey3 of the Global Forest Resources Assessment 
2010 (FRA 2010) carried out by the Food and Agriculture Organization of the United Nations (FAO) and 
with many regional or national partners. An operational system has been developed by the JRC for the 
processing and change assessment of a large data set of multi-temporal medium resolution imagery.  
Time-series of moderate resolution remote-sensing data (mainly Landsat imagery) are attached to each 
sampling location through a quality-controlled, standardized and decentralized process. For the FAO’s 
FRA2010 RSS exercise, the South Dakota State University (SDSU) produced a global database of multi-
temporal 20 km × 20 km sample tiles4 extracted from the USGS GLS archives. For the portion of the 
sample tiles that are not available from the GLS database or have persistent cloud contamination, other 
Landsat imagery or alternative remote sensing data have been used by JRC. This global systematic 
sampling scheme has been developed jointly by FAO and the JRC to estimate rates of deforestation at 
global or continental levels at intervals of 5 to 10 years. FAO is using the tool to work with countries to 
validate land-use and land-use change as part of the FRA work. The tool’s interface makes it easy to label 
land-use changes that are often related to changes in land-cover. Where there is change from or to forest, 
we are particularly interested in recording what the new land-use is, and thus collecting information on the 
drivers of forest loss and gain. 
 
A methodology has been selected in view of the need to interpret a large set of multi-temporal medium 
resolution satellite imagery. The main task is to assess as accurately as possible for each sample unit the 
forest cover and forest cover change between three dates or along two periods:1990-2000 then 2000-
(2005)-2010.The following steps have been developed for the processing & analysis of the sample units: 
 
   1. A 5 ha Minimum Mapping Unit (MMU) has been selected as appropriate for the specific purpose of 

the global assessment. 
   2. Multi-date image segmentation is applied on calibrated and normalised satellite image pairs; groups of 

adjacent pixels that show similar land cover change trajectories between two dates are delineated 
into objects with a 5 ha MMU. 

   3. Selection of training areas for land cover labelling and production of representative spectral signatures 
for each land cover class. 

   4. Automatic classification of segments with pre-assignment of land cover labels: the segments are 
automatically labelled separately for each assessment date by supervised digital clustering and 
classification procedures using the set of representative spectral signatures, leading to preliminary 
forest cover maps. 

   5. Visual verification and final assignment of land cover labels: visual interpretation will be conducted 
interdependently on multi date imagery to verify and to adjust the labels pre-assigned to each 
segment for the different dates. 

 
The analysis includes a crucial final step of visual verification and final assignment of land cover labels 
which is carried out by forestry national officers or remote sensing experts (this step applies also for land 
use labels in a second validation process after automatic transformation from land cover to land use). The 
visual interpretation is conducted interdependently on two-date imagery to verify and to adjust the labels 
pre-assigned to each segment for the different dates. A dedicated stand-alone application has been 
developed for this purpose. The application is a graphical user interface, called the JRC Land Cover 
Change Validation Tool. The aim of this tool is to provide a user-friendly interface, with an optimised set of 
commands to navigate through and to assess a given dataset of satellite imagery and land cover (or land 
use) maps, and to correct easily the land-cover (or land-use) labels as appropriate. The present technical 
document describes the steps for the installation of the tool on a personal computer, as well as the 
detailed features of this dedicated graphical user interface.  
                                                 
2 http://ies.jrc.ec.europa.eu/index.php?page=action-42003 
3 http://www.fao.org/forestry/fra/remotesensingsurvey/en/ 
4 available at http://globalmonitoring.sdstate.edu/projects/fao/index.html 
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2. Terms and conditions of use of the Tool 
 
The data and products described in this document are subject to a disclaimer notice and a copyright 
notice: 
  
Disclaimer Notice 
  
Information on the Joint Research Centre (JRC) products does not necessarily engage the responsibility 
of the European Institutions. The European Commission accepts no responsibility or liability whatsoever 
with regard to the material described in this document. This material is information of a general nature 
only, which is not intended to address the specific circumstances of any particular individual or entity. It is 
not necessarily comprehensive, complete, accurate or up to date. It is sometimes linked to external 
products which the Commission services have no control and for which the Commission assumes no 
responsibility. This disclaimer is not intended to contravene any requirements laid down in applicable 
national law nor to exclude liability for matters which may not be excluded under that law.  
 
The JRC declines all responsibility for any product or software errors or deficiencies or for any damages 
arising from them. It is our goal to minimise disruption caused by technical errors, and we would strongly 
encourage you to take all possible steps to protect yourself against such disruption and to communicate 
any errors detected or problems encountered to the contact name provided for this material. If errors are 
brought to our attention, we will try to correct them.   
  
Copyright Notice  
 
This document includes information, which is made available by the European Commission (the 
"Commission"). The Information is made available in order to enhance public knowledge concerning the 
activities of the Commission. The Information has been supplied by Commission staff, and/or by 
organisations (in this specific case, the partners of the JRC TREES-3 project) involved in research and 
development activities and/or in the Commission's programmes (the "Information Suppliers"). All title and 
intellectual property rights, including, but not limited to, trademarks, copyrights in and to the information, 
and any copies thereof in whatever form, are owned by the Information Suppliers, and/or by the 
Commission, and/or by other parties, and are protected by the applicable laws. Any trademarks or names 
being used are for editorial purposes only, and to the benefit of the trademark owner, with no intention of 
infringing upon that trademark. Except where otherwise noted, all document contents are: © European 
Communities. All rights reserved. 
 
 
Product Access and Redistribution 
 
1. Use for scientific use - Parts or all of the dataset can be freely used for further use in scientific 
applications under the condition that the source will be properly quoted in published papers, journals or 
reports. By way of an example, the Land Cover/Use Change Validation Tool should be quoted in the form 
"TREES-3 project. European Commission, Joint Research Centre, 2011".  
 
2. Reproduction for non-commercial redistribution – Reproduction of part or the totality of the products for 
non commercial distribution, e.g. via the Internet, is authorised, provided that the user obtains written 
permission from the TREES-3 project and ensures proper referencing of the source (see above), including 
the establishment of at least one link to the JRC Institute for Environment and Sustainability web page5 in 
case of reproduction in a web site.  
 
3. Reproduction for commercial redistribution – Whenever the digital database will be used for commercial 
purposes, a commercial license must be requested to the Joint Research Centre. 
 

                                                 
5 http://ies.jrc.ec.europa.eu/ 
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3. Overview of the Tool 
 
 
A dedicated stand-alone application has been developed for visual verification and re-assignment of 
land cover / land use labels on sample units of 20 km × 20 km size. The visual interpretation is 
conducted interdependently on two-date imagery to verify and to adjust the labels pre-assigned to 
each segment for the different dates. The application is a graphical user interface, called the JRC 
Land Cover/Use Change Validation Tool. The aim of this tool is to provide a dedicated user-friendly 
interface, with an optimised set of commands to navigate through and to assess a given dataset of 
satellite imagery and land cover (or land use) maps, and to correct easily the land-cover (or land-use) 
labels - which are recorded in a ESRI shapefile6 - as appropriate. The fully automatic and simple 
navigation through all user sample images makes this stand-alone application a key tool in the 
validation process, i.e. the visual verification and final assignment of land cover / land use labels. 
 
The present technical document describes the steps for the installation of the tool on a personal 
computer, as well as the detailed features of this dedicated graphical user interface.  
 

4. Installation 
 

4.1. Minimum System Requirements 
 
For the best visualization of the tool, the screen resolution has to be set up at 1600 x 1200 pixels or 
finer resolutions. In the case of the “Laptop version” (aimed at Laptop computers with smaller 
screens) the screen resolution should be set up at 1024 x 768. 

4.2. Operating System 
 
Windows OS: NT/2000/XP/Vista/7 (32/64 bit).  
 
UNIX OS: the IDL7 Virtual Machine or IDL software license has to be installed as the version provided 
with the tool is valid for Windows Operating System only. In this case of UNIX OS the software “\JRC-
GEM\L2\RUN_Validation_Tool.sav” has to be launched. It has not been fully tested by JRC which 
declines all responsibility for any software errors or deficiencies. 

4.3. Installation Procedure 
 
The ‘LCC_Validation_Tool’ comes as a stand-alone IDL executable package (.sav) running on a 
distributable version of the IDL Virtual Machine (© IDL see http://www.ittvis.com/).  
There is no need for software installation or configuration. 

4.4. First execution 
 
In order to run the LCC Validation Tool, double click the ‘RUN_Validation_Tool.exe’ file, located in the 
main directory; click ‘Continue’ when the IDL Virtual Machine Splash Screen pops-up; select the 
appropriate resolution between “full”, “medium” or “laptop” resolution. 
From the menu option ‘File’ and ‘Select data file’ select the provided *.csv-file. A test file is located in 
‘Test Data Set’ directory. 

 
6 http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf or http://en.wikipedia.org/wiki/Shapefile 
7 See ITT Visual Information: http://www.ittvis.com/ProductServices/IDL.aspx 

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
http://www.ittvis.com/ProductServices/IDL.aspx


5. Software overview and features 
 

5.1. Start-up 
 
By double clicking the “LCC_Validation_Tool.exe” file, you will first have to select: 

1/ the execution mode (validation of land cover or land use)  
2/ the resolution that best fits on the available computer screen. 
 

 
 

 
The graphical user interface will then appear as top-screen application. 
 
Note: for JRC sample Units over Africa, the legend need to be changed before opening the data file, using the 
more detailed land cover legend used for Africa units. 

 
 

 
 

Through the menu File -> Select data file is possible to load the *.csv file containing all information 
regarding the sample datasets the validator has to work with (see Annex1 section for more 
information regarding the *.csv file structure).  
 

 
 



5.2. Interface structure 
 
The interface is divided in 3 sections, the images on the left, the classifications in the centre and the 
navigation/re-labelling tools on the right; the two windows on top are showing image and according 
classification from ~1990, while the two windows below refer to ~2000. The legend is on top-right. 
 

 
 
When available, the image for year 2005 or 2010 and corresponding land cover map / classification 
can be displayed by checking the ‘Display 2005 dataset’ option. The 2000 image and classification 
will appear then on top while the 2005 data will be shown below. In this case, all 1990-2000 
naming/terms will be replaced by 2000-2005 or 2000-2010 naming/terms.  

5.3. Options for Display of Satellite Imagery 

5.3.1. Image info 
 
The user can find the name of the image (composed of geographical location, reference period 
and acquisition date) on top of the image window. The number of bands and the band 
combination currently used to display the colour composite (default is Mid-IR, Near-IR, Red 
corresponding to Landsat TM or ETM+ bands 5-4-3) are shown at the bottom of the display.  

 
 

 

1990 

2000 
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For a better image visualisation it is possible at any time: 
- to change the RGB band combination by selecting the according bands from a drop-down list; 
- to choose from the drop-down list to the right one of the predefined stretch options; 
- to calculate the spectral statistics of a restricted area of 

one image only (AOI), select a stretch option and apply the 
derived lookup table to the whole image or even to the 
image of the other date  which is useful e.g. in cases of 
clouds or problematic full-image statistics. 

 
 
 

5.3.2. Image flickering 
 

By clicking with the right mouse button over image ~1990 or ~2000 it is possible to overlay the 
two datasets. This allows for a better identification of land cover/use changes (flickering). 
 

5.3.3. Image navigation tools 
 

The four main display windows (the two images and the two classifications) are always linked 
together. By using the navigation section it is possible to:  
 
 

 
 
 
 
• zoom and pan trough the images by drawing a ‘Area Of 

Interest’ (left mouse button) or by selecting a predefined 
square (1/16, 1/9, 1/4) in the pixel shift options 

• increase or decrease the current zoom scale and reset to 
the full extend 

• shift to any direction by a predefined number of pixels or 
image section (1/16, 1/9, 1/4). 

 
 
 
 

 
 

 
 
 
 

By clicking with the right mouse button over the 
zoom window, it is possible to visualize the 
localisation of the sample site. 
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5.4. Classification Interaction  

5.4.1. Classification overlay 
 

In order to facilitate the validation process, it is possible to display the classified polygon outlines 
over the images by selecting “Overlay Segments” and to choose among three colour options 
(‘Color’ = legend colour). 

 

 

5.4.2. Selection of Polygon(s) 
 

It is possible to select polygons in the image or the classification window by using the left mouse 
button with two options: 
a) One polygon at a time or 
b) Multiple polygon selection when the “Multiple selection” option is checked  
 
By checking the “Multiple selection” option, it is also possible to select all polygons in the visible 
image portion corresponding to a predefined class (from drop-down list). The two options / 
methods can be used in sequence. 

 

           
  
 

Notes:  
1. by clicking a polygon a second time it will be un-selected (and displayed in black) and 
removed from the selection list area to the right of the classification window; 
 

 
 

2. By flagging the “Multiple selection” option, only polygons entirely contained in the visible 
image portion are selected; 

3. all selected polygons will be un-selected if any zoom or panning is done. 
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5.4.3. Assigning a new class to a polygon  
 

To assign a new land cover/use class to selected polygons, two steps are necessary:  
1. First select the destination class from the drop-list menu,  
2. Then click on “Recode” button below. 
 
The recoding has to be done independently for the 1990 and 2000 datasets. 
 
After pressing ‘Recode’ Class colours and legend are updated accordingly. The selected 
polygons are kept in the display windows and lists. In case of errors, the “Undo” button can 
restore the last recode actions. 
 
The example below shows the 1990 dataset before and after a few re-labelling steps. 

 
 

      
 

      
 
 

5.4.4. Overwrite all labels of a map / classification 
 

If no change or few changes occurred between two dates, it is possible to copy all the labels of 
one date to the other date through the menu Tools-> Overwrite. This function can be applied for 
the whole image or for a specified AOI. The ‘skip selected’ function will overwrite all the labels of 
one date to the other one (whole image), except the polygons that are selected. 
 
    

 
 
 

UNDO is not possible!       
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5.4.5. Predefined selection 
 

 
 
 
 
 

In order to make the validation process as efficient and 
rapid as possible, there are different options to display 
the classification results.  

 

 
 

 

5.4.6. Masking portion of images using classification  
 

By checking the “Mask unselected class” option it is possible to hide all portions of the image that 
do not match with the class specified by the selected polygon (if more than one has been 
selected, the reference class is taken from the object at top of the list).  
In the example below the class “Tree Cover” has been chosen for visualization; all other classes 
have been masked in the image windows of both periods.   
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5.5. Changing working dataset 
 
 
To change the working dataset (i.e. the sample unit) it is enough to click on the “Next” or “Previous” 
buttons. The display in the visualization windows appears in the order following the structure of the 
*.csv file. In case some datasets have already been validated the “Only not yet processed” option can 
be checked to skip them. As such only not yet processed datasets will be displayed.  To go directly to 
a specified site, the ‘Jump to’ option can be used.   
 

 

 

5.6. Save change to shapefile  
 
Any re-coded object is automatically saved into shapefile when  

a) The “Next” or “Previous” button is click or  
b) Before exporting the active shapefile (using the “Tool --> Save shape as” utility). 

 

5.7. Export outlines of images as Google Earth compatible KML file 
 
Using the “Generate Google KML from available dataset” function in the File menu’ it is possible to 
generate a Google Earth compatible KML file containing the outlines of the available set of images in 
the selected folder. For better orientation grid lines have been added with a cell size of 5x5km, 
dividing the image extent in 16 equally sized grid cells. 
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Annex I: file structure and known bugs 
 
Input *.csv file structure 
 
The *.csv input file contains the list of sample units to be ‘validated’, the corresponding shapefiles and 
related image filenames. It is updated after each session and a backup is created (name.csv_bkup). 
It is a comma delimited file, containing 9 fields: 

 
Lat_Lon, Box90, Box00, Box 05, Classif, Validator, Date, Processed, Changed, Notes 

 
File Naming Convention 
 
The results of segmentation and automated labelling are provided as shape files (*.SHP and related 
files *.dbf, *.shx, *.prj), together with the image files (*.TIF). 
 
The shape file name indicates the latitude and longitude of the sample unit centre, e.g.: 
• N30_E110.shp (similar to the other associated files .dbf, .shx, .prj) 
 
The corresponding image files are labelled accordingly, indicating in addition the reference year and 
the acquisition date of the imagery, e.g.: 
• N30_E110_90_12121991_f.tif (reference year 1990, acquired on 12 Dec 1991) 
• N30_E110_00_11112000_f.tif (reference year 2000, acquired on 11 Nov 2000) 
• N30_E110_05_07012005_f.tif (reference year 2005, acquired on 07 Jan 2005) 
 
Building a new csv file based on existing datasets 
 
Using this function is possible to generate a new input csv file based on dataset available in a 
specified directory: a first search based on *.shp files identifies available datasets to be insert into the 
csv file; related images are selected using the following criteria: [Shapefile name without 
extension]*[_90_]*[_f.tif]; same for 2000 and 2005. The operator will assign the desired filename at 
runtime. The reference template is created automatically. 
 

 
Format of Attribute Tables 
 
The data base file associated with the Shape file (dbf-file) has the following structure: 
  

ID AREA ORG REC 1990 2000 CH_90_00 ORG_05 2005 CH_00_05 
1 123456 1020 1220 12 20 1220 10 30 2030 
2 78910 1260 1260 20 60 2060 20 60 6060 
Not-used Not-used Not-used Not-used Used Used Used Not-used Used Used 

 
ID, SHAPE               system-generated segment identifications 
AREA   indicates the segment area in meter2 
ORG  original extended class codes 1990 and 2000 (concatenated) 
REC                 class final codes 1990 and 2000 (concatenated) 
1990  class code 1990, changes if modified during validation 
2000  class code 2000, changes if modified during validation 
CH_90_00 class code 1990 and 2000 (concatenated), changes if modified during validation 
ORG_05                 original class codes 2005  
2005                        class code 2005, changes if modified during validation 
CH_00_05               class code 2000 and 2005 (concatenated), changes if modified during validation 
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Legend: colours and codes  
 
The colours, class names and associated codes of the legends “Land Cover” and “Land Use” are 
summarized below.  The “Land Cover” legend for Africa differs for 3 classes: a different code for 
“Other Wooded Land class (22 instead of 20)” and “Other Land Cover” class is divided into two sub-
classes: “Other Vegetation Cover” and “Bare & Artificial” 
 
 

‘Land Cover’ Legend 
 

           

Specific classes for Africa LC legend  

 
 
 
 
 

‘Land Use’ Legend 
 

 
LAND USE CLASS CODE LAND USE CLASS CODE

FOREST 11

OTHER WOODED LAND 12
OTHER TREE COVER 13

NATURAL HERBACEOUS 14

OTHER LAND USE 30 AGRICULTURE 15

BUILT-UP 16

BARE 17

WETLAND 19
WATER 18

NO DATA 99  
 
 
 
 
         
 

OTHER WOODED LAND 22

OTHER VEGETATION COVER 35

BARE & ARTIFICIAL 40
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Building a new input  template based on existing csv file 
 
The IDL binary file ‘[dateset_name]_template.sav’ contains information for reading the input 
[dataset_name].csv file; usually it is provided together with the csv file. In case the 
‘[dataset_name]_template.sav’ file gets corrupted or lost or the input csv file is different from what 
provided (e.g. different name), a wizard will ask to recreate the template.  
Wizard step 1 shows the file structure and asks to specify the file structure (select “Delimited”) 
 

 
 
 
 

The first line is the header containing fields description that is necessary to skip setting   “Data Starts 
at Line” at 2.  
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The field delimiter has to be set as “Comma” and it has to be ensured that all nine fields are being 
detected. 

 

 
 
 
For any field select “String” as “Type” and click “Finish”. 
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nown BugsK  

 image). This is due to a simplification of self intersecting polygons into simple 
nd smaller triangles. 

 

 
On rare occasions it is possible to find black triangles on the classification (as seen on the right 
window in the following
a
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Author(s): Dario Simonetti, René Beuchle and Hugh D. Eva 
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Abstract 
 
 
The JRC TREES-3 project aims at estimating forest cover changes at continental and regional levels for the 
tropical belt for the periods 1990-2000 and 2000-(2005)-2010 based on a systematic sample of forest cover 
change maps. An operational system has been developed for the processing and change assessment of a 
large data set of multi-temporal medium resolution imagery (sample units of 20 km x 20 km size analysed from 
with Landsat imagery).  The main task is to assess as accurately as possible for each sample unit the forest 
cover and forest cover change between two dates. 
 
The analysis includes a crucial final step of visual verification and final assignment of land cover labels which is 
carried out by forestry national officers or remote sensing experts from tropical countries. The visual 
interpretation is conducted interdependently on two-date imagery to verify and to adjust the labels pre-assigned 
to each segment for the different dates. A dedicated stand-alone application has been developed for this 
purpose. The application is a graphical user interface, called the JRC Land Cover Change Validation Tool. 
The aim of this tool is to provide a user-friendly interface, with an optimised set of commands to navigate 
through and assess a given dataset of satellite imagery and land cover maps, and to correct easily the land-
cover labels as appropriate. FAO is collaborating with JRC in this work under the Global Forest Resource 
Assessment (FRA) Remote Sensing Survey. JRC has added functionality to the tool to enable labelling of land-
use classes that are part of the FRA classification. 
 
The present technical document, entitled “User Manual for the JRC Land Cover/Use Change Validation Tool” 
describes the steps for the installation of the tool on a personal computer, as well as the detailed features of this 
dedicated graphical user interface. The authors welcome feedback from potential users of the tool, in particular 
reporting of any potential software issue or providing suggestions for improvements of future versions of the 
tool. 



How to obtain EU publications 
 
Our priced publications are available from EU Bookshop (http://bookshop.europa.eu), where you can place 
an order with the sales agent of your choice. 
 
The Publications Office has a worldwide network of sales agents. You can obtain their contact details by 
sending a fax to (352) 29 29-42758. 
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The mission of the JRC is to provide customer-driven scientific and technical support for the 
conception, development, implementation and monitoring of EU policies. As a service of the 
European Commission, the JRC functions as a reference centre of science and technology 
for the Union. Close to the policy-making process, it serves the common interest of the 
Member States, while being independent of special interests, whether private or national. 
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